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Log:

11-Jun-2001


Extracted from Athletics3D

13-Jul-2001

Redesign of World3dModel: W3D_CAMERA, W3D_CAMERA_KEYFRAME, W3D_MODEL_INSTANCE and W3D_MODEL_INSTANCE_KEYFRAME moved into World3dModelCamera and World3dModelModelInstance based on World3dModelFrameObject, World3dModelCameraKeyframe and World3dModelModelInstanceKeyframe based on World3dModelKeyframe

17-Jul-2001


Redesign finished – compiles again!

18-Jul-2001


Done with Vector3f, Matrix44f, Quaternion

Done with Camera tools: Pan, set FOV, set Depth, some bugs with Roll and Rotate

19-Jul-2001


Fixed roll and rotate bug (axis vector was not normalized when giving it to Quaterninon)

21-Jul-2001


Done with rotating of model preview (rotate eye around target)

22-Jul-2001


Done with support for loading Autodesk 3DS meshes

07-Aug-2001


Done with specification of GLTextureManager, and World3dModel* classes

1. Idea

Tomaskovic engine3d (a.k.a. SuperEngine 3D) is based on OpenGL.

It is a higher level of abstraction for managing 3d world that uses OpenGL as rendering API.

2. Window, DeviceContext, OpenGL RenderingContext and OpenGLViewport











Whether your application is using one fullscreen window, or you need rendered child window(s) on your window – in both cases, you will create your window that will have its Device Context (DC).

In order to render to DC of your window with OpenGL, you must create OpenGL RenderingContext (RC) for each DC where you’re planing to render with OpenGL. Also, you need to define OpenGL rectangle Viewport on DC where you want to render (you can have multiple viewport on single DC).

GLRenderingContext and GLViewport classes encapsulates this logic.

Steps to take:

1. If you already have your window which you want to use (or some part of it) as rendering surface – check GLRenderingContext class to see how to create OpenGL RenderingContext for your window’s DC (and then GLViewport)

2. If you have your parent window and want to create rendered child window – check GLChildWindow class

3. If you are building a game, starting from scratch, and you need to create one fullscreen rendered window with StateMachine engine – check GLGameWindow class

4. If you need just a test window for a start – check GLWindow class

2.1. GLRenderingContext

DESCRIPTION:

GLRenderingContext class creates OpenGL Rendering Context (RC) on given hDC, and does repainting of GLViewports that you have on that hDC.

When using OpenGL API to paint on your window's device context (HDC), you must create OpenGL Rendering Context for that HDC.

Every GLRenderingContext you are using is having its own TextureManager because OpenGL can't share loaded textures between different Rendering Contexts.

USAGE:

     // Create your window (with CS_OWNDC style in your WNDCLASS!)

         // ... you should know this ...

     // Create instance of GLRenderingContext

         GLRenderingContext glRenderingContext;

     // Activate it on your HDC with desired iBitsPerPixel (e.g. 24)

         glRenderingContext.Create(hYourDC, 24);

     // Add your GLViewports (you should create ones on your window)

         glRenderingContext.AddGLViewport(pYourGLViewport);

     // When you want to repaint viewports on your HDC call:

         glRenderingContext.Draw();

2.2. GLViewport

DESCRIPTION:

GLViewport class represents OpenGL viewport on your Device Context (DC).

You can have multiple GLViewports on single DC, but all of them are inserted into single GLRenderingContext you have attached to your DC.

USAGE:

     // Extend GLViewport class implementing DrawImpl(...) method

     // Add your class to GLRenderingContext of your DC

         glRenderingContext.AddGLViewport(pYourGLViewportBasedClass);

     // Set viewport rect (position and size) on DC

         pYourGLViewportBasedClass->SetViewportRect(0, 0, 320, 240);

     // Set background color (if you're going to clear surface with

     // this viewport)

         pYourGLViewportBasedClass->colorBackground = RGB(0, 0, 0);

     // Later, when you call glRenderingContext.Draw(), it will call

     // Draw() of GLViewport that will bound OpenGL to given rectangle

     // on DC, and Draw() will call your DrawImpl(...) for actual

     // rendering

     // In your DrawImpl, you should set-up OpenGL (lighting, textures,..)

     // but you can also use utility functions of GLViewport to clear

     // depth and color buffer, e.g.:

         GLViewport::ClearColorAndDepthBuffer();

2.3. GLChildWindow 

DESCRIPTION:

GLChildWindow class encapsulates win32 window with GLRenderingContext on its DC, also this class extends GLViewport and inserts itself into GLRenderingContext as only viewport on this window.

Use this class as base class for your class that will implement DrawImpl(...) method.

USAGE:

     // Derive your class from this one, 

     // and implement DrawImpl(...) method

     // Create instance of your class

         MyGLChildWindow myGLWindow;

     // Create actual win32 window

         myGLWindow.Create(hInstance, hwndParent,

             10, 10, 320, 200, 24);

 Here, window was created with OpenGL rendering context.

 OnPaint handler will use GLRenderingContext which will forward painting back to this window

 (it is only GLViewport in this context), and which  will finally call DrawImpl(...) you will implement..

2.4. GLTextureManager



GLTextureManager is texture manager used in context of GLRenderingContext.

Since textures can not be shared between different OpenGL rendering contexts, each GLRenderingContext has its own GLTextureManager. You will get reference to GLTextureManager on DrawImpl(...) of your GLViewport.

You should use FindUserTextureID(pszTexturePathFilename) to get user ID of your bitmap file to be loaded as texture. (user IDs are shared between all GLTextureManagers).

Later, you should use FindGLTextureID(iUserTextureID) to get OpenGL texture ID (GLTextureManager will do loading here if texture file is not yet loaded, also, it will apply min and mag filters).

3. Camera, World3d, Objects3d and Object3dModels















You can implement GLViewport:DrawImpl(…) the way you like. 

Solution SuperEngine3D offers include using instance of World3d and Camera. General schema is shown above, you should implement your GLViewport::DrawImpl(…) like here:


camera.Apply();


world3d.Draw(…);

3.1. Camera

DESCRIPTION:

Camera class encapsulates logic to handle camera to view your OpenGL world.

OpenGL is using GL_PROJECTION and GL_MODELVIEW matrices to modify the way you view your world. When both matrices are initialized to identity matrices, OpenGL viewport is using some sort of 'camera' placed at center of coordinate system (0, 0, 0) looking down the negative Z-axis, having Y-axis going from bottom to top of viewport, and X-axis from left to right - having center of coordinate system in the middle of the viewport.

If you want to use perspective projection with concept of camera (based on so-called modelview duality), you should set parameters of this Camera (you can use Apply* functions to modify them), and call camera.ApplyToGLViewport(). This class encapsulates all logic to handle GL_PROJECTION and GL_MODELVIEW matrices.

USAGE:

     // Create instance of this camera

     // (e.g. member variable of your GLViewport implementation)

         Camera camera;

     // Set its parameters

         camera.SetOrientation(

             0.0f, 0.0f, -20.0f, // eye coordinates

             0, 0, 0,            // target is center of coordinate system

             1, 0, 0             // up is in y-axis direction

             );

         camera.SetFieldOfView(60.0f);

     // Modify it

         camera.ApplyYaw(...);

     // Apply it on GLViewport::DrawImpl(...) before drawing world

         camera.ApplyToGLViewport();

         world3d.Draw(...);      // for example..

3.2. World3d and Object3d




DESCRIPTION:

World3d is is simple collection of objects based on Object3d.

If you call Clear() method it will delete all Objects3d.

Destructor of World3d will also call Clear() method.

Object3d is base class for 3D objects used in World3d.

3.3. Object3dModel, ModelObject3d – support for Autodesk3ds and Wavefront Object3dModels













DESCRIPTION:

Object3d is base class for 3D objects used in World3d.

ModelObject3d is simpe implementation of Object3d.

It has pointer on it's model - class based on Object3dModel that implements Draw(...) and DrawWireframe(...) that are doing actual drawing.

Object3dModel is base class for models of 3d objects.

Child class should implement Draw(...) and DrawWireframe() methods.

WavefrontObject3dModel and Autodesk3dsObject3dModel are useful implementations of this class.

3.4. Support for Autodesk 3DS files - Autodesk3dsDatabase and Autodesk3dsObject3dModel












Autodesk3dsDatabase class loads all meshes (objects) from Autodesk 3DS files.

Autodesk3dsObject3dModel is implementation of Object3dModel that uses mesh from Autodesk3dsDatabase (you must give pointers to mesh and Autodesk3dsDatabase when constructing this object).

A3DS_MESH is autodesk 3ds mesh, that is having array of vertices and faces who indexes these vertices (zero-indexes).
3.5. Support for WAVEFRONT obj files - WavefrontObject3dModel
















WavefrontObject3dModel class is implementation of Object3dModel that uses 3d objects from Wavefront obj files.

WF_TRIANGLE_FACE is single triangle face having indexes of WF_GEOMETRIC_VERTEX, WF_TEXTURE_VERTEX and WF_VERTEX_NORMAL (-1 if some of them is not used)

4. World3dModel – objects and keyframes










5. World3dModel


World3dModel represents collection of objects (3d objects and cameras) in 3d world, with keyframes.

World3dModel has collection of model definitions (W3D_MODEL_DEFINITION) used by instances of these 3d objects - World3dModelModelInstance. Model instances are having keyframes - World3dModelModelInstanceKeyframe.

World3dModel may also have cameras. Each World3dModelCamera is having keyframes - World3dModelCameraKeyframe.

6. State machine engine













7. 3D Game application architecture

















8. APPENDIX A - Creating new VisualC++ project (for a 3d game?)

Follow these steps:

1. Run VisualC++ 6.0

2. Choose File->New, Project tab, pick “Win32 Application”, edit “Location” where you want to place your project, and type your project name above (e.g. MyGame)

3. On Step1 tab – choose “A Simple Win32 Application”, then “Finish” and “Ok”

4. Click on “Class view” in Workspace window, you should have WinMain function (in MyGame.cpp):

// MyGame.cpp : Defines the entry point for the application.

//

#include "stdafx.h"

int APIENTRY WinMain(HINSTANCE hInstance,

                     HINSTANCE hPrevInstance,

                     LPSTR     lpCmdLine,

                     int       nCmdShow)

{

 
// TODO: Place code here.


return 0;

}

5. Now follow steps how to add Super Engine3D to your VC++ project

9. APPENDIX B - Adding Super Engine3D support to your project

1. You should unpack super-engine-3d.zip archive and have following structure somewhere on your disk

\your-folder

    \super-engine-3d

        \src

            \tomaskovic

                \util

                \engine3d

                \win

                \xml

2. You should have your top-secret VC++ project opened

3. Use Project->Add to project->Files… to add all sources (*.cpp and *.h) from \util, \engine3d, \win and \xml folders of super-engine-3d

4. Click Project->Settings, Select “All Categories” in “Settings For” combobox, expand “Source Files” of your project, select all new *.cpp files, select “C/C++” tab, pick “Precompiled Headers” and click “Not using precompiled headers” radiobox – click Ok
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GLViewport


Create(x, y, width, height) ;


Destroy();


Draw() {


    // Set GL viewport


    // Call DrawImpl of child class


    DrawImpl();


}


virtual void DrawImpl() {


    // This will child class of GLViewport implement


    // (should use camera, draw world objects, etc.)


}


x, y


iWidth, iHeight





GLRenderer


Create(hDC, iBitsPerPixel) {


    // Set PixelFormat


    // Create RenderingContext


    // Activate RC for DC


    // GL Initialization


}


Destroy();


AddGLViewport(pGLViewport);


Draw() {


    // Clear pixel and Z buffers


    // Draw all viewports


    // Copy backbuffer to screen


}


hDC;


hRC;


pixelFormatDescriptor;


vGLViewports





Autodesk3dsDatabase


BOOL LoadFromFile(pszFilename);


A3DS_MESH*


    GetMeshByName(pszName);


strPathFilename;


vMeshes; // A3DS_MESH structures





Autodesk3dsObject3dModel


Autodesk3dsObject3dModel(


    pAutodesk3dsDatabase, 


    pszMeshName);


Draw(…);


DrawWireframe(…);


GetBounds(…);


pAutodesk3dsDatabase


pA3DS_MESH





1





Object3dModel


virtual Draw(…) = 0;


virtual DrawWireframe(…) = 0;


virtual GetBounds(…) = 0;





strName;











TextureManager





GLuint LoadTextureFromBMP(pszFilename);


GLuint LoadTextureFromBMPWithMask(


    pszFilename, pszMaskFilename);





aTextures // array of TEXTUREs


default_glTextureMinFilter


default_glTextureMagFilter






































World3dModel


void SetPathFilename(pszPathFilename);


BOOL Load(pInputStream);


void Save(pOutputStream);


vModelDefinitions;	


    // Vector of  W3D_MODEL_DEFINITIONS


vFrameNames;


vFrameObjects;


    // World3dModelCamera &  World3dModelModelInstance


vAutodesk3dsDatabases;


strPathFilename;


// UTILITY FUNCTIONS:


W3D_MODEL_DEFINITION* GetModelDefinition(pszName);


void PopulateWorld(iFramePosition, World3d &world3d);


int GetTotalFrames();


void RemoveFrameObject(pszName);


void RemoveModelDefinition(pszModelName);


XMLElement* SaveModelDefinition(


    W3D_MODEL_DEFINITION *pModelDefinition, 


    pszWorld3dModelPathFilename);








World3dModelModelInstance


strModelName;


XMLElement* Save();


BOOL Load(XMLElement* 


    pEModelInstance);


void ApplyToObject3d(


    iFramePosition, &object3d);





World3dModelCamera


XMLElement* Save();


BOOL Load(XMLElement* pECamera);


BOOL ApplyToCamera(


    int iFrameNo, Camera* pCamera);


void SaveCameraStateAsKeyframe(


    int iFrameNo, Camera* pCamera);








World3dModelCameraKeyframe


fEyeX, fEyeY, fEyeZ;


fTargetX, fTargetY, fTargetZ;


fUpX, fUpY, fUpZ;


fFOV;


void ApplyToCamera(pCamera);


XMLElement* Save();





World3dModelModelInstanceKeyframe


fPosX, fPosY, fPosZ;


fRotX, fRotY, fRotZ;


void ApplyToObject3d(&object3d);





W3D_FRAME_NAME


iFrameNo;


szName[256];





W3D_MODEL_DEFINITION


szName[256];


szFilename[512];


szType[64]; // WAVEFRONT / AUTODESK3DS


pObject3dModel;	// Loaded later
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WavefrontObject3dModel


Draw(…);


DrawWireframe(…);


GetBounds(…);


LoadFromFile(pszFilename, 


    pTextureManager);


aGeometricVertices;


aTextureVertices;


aVertexNormals;


aTriangleFaces;


aMaterials;


aGroups;





ModelObject3d


Draw(…);





pObject3dModel;


isWireframe;
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GLRendereringContext


Create(hDC, iBitsPerPixel) {


    // Set PixelFormat


    // Create RenderingContext


}


Destroy() {


    // Delete RC


}


AddGLViewport(pGLViewport);


Draw() {


    // Activate RC for DC


    // Draw all viewports


    // Copy backbuffer to screen


}


  hDC;


  hRC;


  textureManager;


private:


  pixelFormatDescriptor;


  vGLViewports;








Athletics3DApp implements GameWindowListener





GameWindowListener


OnPaint();


OnMouseLButtonUp(x, y);


OnMouseLButtonDown(x, y);


OnMouseMove(x, y);


OnMouseLButtonDrag(x, y);


OnKeyDown(iKeyCode);


OnKeyUp(iKeyCode);
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Athletics3DApp


WinMainImpl(hInstance, cmdline) {


    // Create GameWindow


    // Create GLRenderer


    // Create TextureManager


    // Create GLViewport


    // Create MessageRouter


    // LOOP (render+processtime)


}


(GameWindowListener)


OnKeyDown(int iKeyCode) {…}


OnKeyUp(int iKeyCode) {…}


OnPaint() {…}


pGameWindow


pMessageRouter


iMSG_KEY_DOWN


iMSG_KEY_UP








TEXTURE


iTextureID;


iWidth;


iHeight;


szFilename[512];





Instantiated





GameWindow


Create(pszTitle, width, height, bits,  


    isFullscreen, pGameWindowListener);


Destroy();


static WndProc() {


    // Forward messages to 


    // pGameWindowListener


}


hDC


hWnd


hInstance


isActive


isFullscreen


pGameWindowListener
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World3dModelKeyframe


iFrameNo; 





World3dModel


void SetPathFilename(pszPathFilename);


BOOL Load(pInputStream);


void Save(pOutputStream);


vModelDefinitions;	


    // Vector of  W3D_MODEL_DEFINITIONS


vFrameNames;


vFrameObjects;


    // World3dModelCamera &  World3dModelModelInstance


vAutodesk3dsDatabases;


strPathFilename;


// UTILITY FUNCTIONS:


W3D_MODEL_DEFINITION* GetModelDefinition(pszName);


void PopulateWorld(iFramePosition, World3d &world3d);


int GetTotalFrames();


void RemoveFrameObject(pszName);


void RemoveModelDefinition(pszModelName);


XMLElement* SaveModelDefinition(


    W3D_MODEL_DEFINITION *pModelDefinition, 


    pszWorld3dModelPathFilename);








World3dModelFrameObject


World3dModelKeyframe* 


    GetKeyframeAfter(int iFramePosition);


World3dModelKeyframe* 


    GetKeyframeBefore(int iFramePosition);


strName;


strType;	// Camera / ModelInstance


vKeyframes; // objects based on  World3dModelKeyfame


aFrames;	// array of frame integer numbers





// Utility functions:


World3dModelKeyframe* GetKeyframe(iFrameNo);


void RemoveKeyframe(int iFrameNo);


void RemoveFrame(int iFrameNo);


BOOL HasFrame(int iFrameNo);


BOOL HasKeyframe(int iFrameNo);


int GetMaxKeyframeFrameNo();


void AddFrame(int iFrameNo);








Legend				





WF_TEXTURE_NORMAL


i, j, k








WF_TEXTURE_VERTEX


u, v, w











WF_MATERIAL


char szName[512];


WF_COLORF colorAmbient;


WF_COLORF colorDiffuse;


WF_COLORF colorSpecular;


float fShinnes;


char szDiffuseMap[512];


int iUserTextureID;








extends





Object3d


virtual Draw(…) = 0;





fPositionX


fPositionY


fPositionZ


// rotation data





Parent





Child

































































GLChildWindow


Create(hInstance, hwndParent,


    x, y, width, height, iBitsPerPixel)  {


    // Create window


    // Create RenderingContext


    // Create GLViewport


}


virtual:


  OnMouseMove(x, y, flags);


  OnLButtonDown(x, y, flags);


  OnLButtonUp(x, y, flags);


  OnSize(w, h) {


      GLViewport::SetViewportRect(0, 0, w, h);


  }


  OnBeginMouseDrag(int x, int y, int flags);


  OnMouseDrag(int x, int y, int flags);


  OnEndMouseDrag(int x, int y, int flags);


  OnPaint() {


      glRenderingContext.Draw();


  }





  hwnd;


  hInstance;


  isLButtonDown;


private:


  hDC;


  glRenderingContext;








GLViewport


void SetViewportRect


    // Set PixelFormat


    // Create RenderingContext


}


void Draw(&textureManager) {


    // Set GLViewport


    // Set lighting


    // Init viewport (identity matrix)


    DrawImpl(textureManager)


}


void ClearColorBuffer();


void ClearDepthBuffer();


void ClearColorAndDepthBuffer();


virtual void DrawImpl(&textureMgr) = 0;


  x, y, iWidth, iHeight;


  colorBackground;





GLViewport


void SetViewportRect(…);


void Draw(&textureManager);


void ClearColorBuffer();


void ClearDepthBuffer();


void ClearColorAndDepthBuffer();


virtual void DrawImpl(&textureMgr) = 0;


  x, y, iWidth, iHeight;


  colorBackground;





GLRendereringContext


Create(hDC, iBitsPerPixel) ;


Destroy();


AddGLViewport(pGLViewport);


Draw();


  hDC;


  hRC;


  textureManager;


private:


  pixelFormatDescriptor;


  vGLViewports;
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YourGLViewport


…


void DrawImpl(&textureMgr) {


    // … your implementation …


}








GLTextureManager


int FindGLTextureID(int iUserTextureID);


static int FindUserTextureID(pszTexturePathFilename);


TEXTURE* LoadTextureFromBMP(pszFilename);


GLuint LoadTextureFromBMPWithMask(


    pszFilename, pszMaskFilename);


void ApplyTextureDefaultOptions();


Array aTextures;


GLint default_glTextureMinFilter;   


    // GL_LINEAR / GL_NEAREST


GLint default_glTextureMagFilter;








GLChildWindow / GLWindow


Create(hInstance, hwndParent,


    x, y, width, height, iBitsPerPixel) ;


…


OnPaint();


  hwnd;


  hInstance;


  isLButtonDown;


private:


  hDC;


  glRenderingContext;








Object3dModel


virtual Draw(…) = 0;


virtual DrawWireframe(…) = 0;


virtual GetBounds(…) = 0;





strName;











WavefrontObject3dModel


Draw(…);


DrawWireframe(…);


LoadFromFile(pszFilename, 


    pTextureManager);


aGeometricVertices;


aTextureVertices;


aVertexNormals;


aTriangleFaces;


aMaterials;


aGroups;





Camera


SetViewportSize(width, height);


SetWorld3d(pWorld3d);


SetOrientation(fEye XYZ,


    fCenter XYZ, fUp XYZ);


SetFieldOfView(fAngle);


Apply() {


    // Transform GL coordinate 


    // system according to camera


}


ApplyDepth(…);


ApplyPan(…);


ApplyRoll(…);


ApplyYaw(…), 


ApplyPitch(…);


ApplyYawOnEye(…);


ApplyPitchOnEye(…);


fEye XYZ;


fCenter XYZ;


fUp XYZ;


pWorld3d;


iWidth, iHeight;








World3d





AddObject3d(pObject3d);


Draw() {


    // For each object in vector:


        // Transform coordinate


        // system into object space


        // Call pObject3d->Draw();


}





// Vector of all world 3d objects


vectorObject3D; 





Object3d


virtual Draw(…) = 0;





fPositionX


fPositionY


fPositionZ


// rotation data





0..n





ModelObject3d


Draw(…);





pObject3dModel;


isWireframe;
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Autodesk3dsDatabase


BOOL LoadFromFile(pszFilename);


A3DS_MESH*


    GetMeshByName(pszName);


strPathFilename;


vMeshes; // A3DS_MESH structures





StateMachineMessageRouter


void ProcessDeltaTime();


void ProcessTime(dwMilliseconds) {


    // Time to process = given time


    // While we have (first) message in queue


    // (messages are sorted ascending by time to occur)


        // Take first message


        // If message TimeToOccur is in future more than we


        // can move there


        // (i.e. TimeToOccur <= CurrentTime + fTimeToProcess)


            // Remove message from queue


            // (because new messages may be inserted when


            // processing this message on target object)


            // Move to future to time of this message and also


            // decrease TimeToProcess for TimeToOccur - CurrentTime


            // Execute message on target object


            // Delete message


        // Else


            // Stop because we have only future messages in the queue


        // Increase CurrentTime for TimeToProcess that has left


}


void PostMessage(iMessageID, pFrom, pTarget, wParam, lParam,


    float fTimeToOccurRelative);


void SendMessage(iMessageID, pFrom, pTarget, wParam, lParam);


void PostMessage(*pStateMachineMessage);


void DeleteMessagesForTarget(pStateMachine);


void ClearMessagesFrom(pStateMachine);


int RegisterMessage(pszMessageName);


int RegisterState(pszStateName);


void SetKeyboardFocusStateMachine(pKeboardFocusSM);


fCurrentTime;


vStateMachineMessages


vStates, vMessages


dwLastTickCount;


pKeyboardFocusSM;


iMSG_KEY_DOWN, iMSG_KEY_UP





1





Athletics3DApp


…











StateMachine


~StateMachine() {


    pMessageRouter->


        DeleteMessagesForTarget(this)


        ClearMessagesFrom(this);


}





Init(pStateMachineMessageRouter) {


    OnRegisterStates();


    OnRegisterMessages();


    iState = GetInitialState();


    OnEnter(iState);


}





void SetState(int iNewState) {


    if (iNewState == iState)


        return;


    OnExit(iState);


    iState = iNewState;


    OnEnter(iNewState);


}





// Child should implement this:


char* OnGetDescription() { return NULL; }


virtual void OnRegisterStates() {}


virtual void OnRegisterMessages() {}


virtual int OnGetInitialState() = 0;	





void OnEnter(iNewState) {}


virtual void OnMessage(pSMMessage);


void OnExit(iState) {}


iState


pMessageRouter








0..n





SMMessage


iMessageID;


pFromStateMachine;


pTargetStateMachine;


fTimeToOccur;


wParam;


lParam;





Creates message and gives it to MessageRouter
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Delegator





Executor





delegates





(Asociation)





(Agregation)





Autodesk3dsObject3dModel


Autodesk3dsObject3dModel(


    pAutodesk3dsDatabase, 


    pszMeshName);


Draw(…);


DrawWireframe(…);


pAutodesk3dsDatabase


pA3DS_MESH





WF_TRIANGLE_FACE


iGeometricVertexIndex[3];


iTextureVertexIndex[3];


iVertexNormalIndex[3];











WF_GEOMETRIC_VERTEX


x, y, z








Object3dModel


virtual Draw(…) = 0;


virtual DrawWireframe(…) = 0;


virtual GetBounds(…) = 0;





strName;











Autodesk3dsDatabase


BOOL LoadFromFile(pszFilename);


A3DS_MESH*


    GetMeshByName(pszName);


strPathFilename;


vMeshes; // A3DS_MESH structures





Autodesk3dsObject3dModel


Autodesk3dsObject3dModel(


    pAutodesk3dsDatabase, 


    pszMeshName);


Draw(…);


DrawWireframe(…);


GetBounds(…);


pAutodesk3dsDatabase


pA3DS_MESH





Object3dModel


virtual Draw(…) = 0;


virtual DrawWireframe(…) = 0;


virtual GetBounds(…) = 0;





strName;











A3DS_MESH


szName[25]


wVertices;


vertexArray; // A3DS_VERTEX


wFaces;


facesArray; // A3DS_FACE








A3DS_FACE


wVertexIndex1


wVertexIndex2


wVertexIndex3


wFaceInfo








A3DS_VERTEX


x, y, z








(Agregation)





(Asociation)





delegates





Executor





Delegator





owns instance / consist of
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Instantiated
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Legend				





Camera


SetViewportSize(width, height);


SetWorld3d(pWorld3d);


SetOrientation(fEye XYZ,


    fCenter XYZ, fUp XYZ);


SetFieldOfView(fAngle);


ApplyToGLViewport() {


    // Transform GL coordinate 


    // system according to camera


}


ApplyDepth(…);


ApplyPan(…);


ApplyRoll(…);


ApplyYaw(…), 


ApplyPitch(…);


ApplyYawOnEye(…);


ApplyPitchOnEye(…);


fEye XYZ;


fCenter XYZ;


fUp XYZ;


pWorld3d;


iWidth, iHeight;











0..n





Object3d


virtual Draw(…) = 0;





fX


fY


fZ


// rotation data





World3d





AddObject3d(pObject3d);


Draw() {


    // For each object in vector:


        // Transform coordinate


        // system into object space


        // Call pObject3d->Draw();


}


Clear() {


    // Delete all objects3d in vector


}





// Vector of all world 3d objects


vectorObject3D; 





(Agregation)





(Asociation)





delegates





Executor





Delegator
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Owned





Owner





uses





Used





User





instanties
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Delegator





Executor





delegates
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(Agregation)





WavefrontObject3dModel


Draw(…);


DrawWireframe(…);


GetBounds(…);


LoadFromFile(pszFilename, 


    pTextureManager);


aGeometricVertices;


aTextureVertices;


aVertexNormals;


aTriangleFaces;


aMaterials;


aGroups;





WF_GROUP


char szName[512];


char szMaterialName[512];


WF_MATERIAL* pMaterial;


int iFirstFaceIndex;


int iFaces;





1


























TEXTURE


iUserTextureID;     // User texture ID


iGLTextureID;    // -1 if no one yet


iWidth;


iHeight;


szFilename[512];








GLTextureManager


int FindGLTextureID(int iUserTextureID);


static int FindUserTextureID(pszTexturePathFilename);


TEXTURE* LoadTextureFromBMP(pszFilename);


GLuint LoadTextureFromBMPWithMask(


    pszFilename, pszMaskFilename);


void ApplyTextureDefaultOptions();


Array aTextures;


GLint default_glTextureMinFilter;   


    // GL_LINEAR / GL_NEAREST


GLint default_glTextureMagFilter;
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